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Chapter-2 

SPR 

 

Spreadsheet 

A spreadsheet is a computer program that allows the user to store data in a grid of Rows and Columns. 

It is used to record, calculate and compare numerical or financial data.  

There are lots of Spreadsheet programs. But the most widely used spreadsheet program is Microsoft 

Excel. We can understand the uses and applications of spreadsheet with the help of MS Excel 2007.  

Basic Concepts of a Spreadsheet 

Workbook 

An Excel file that contains one or more worksheets is called a workbook. In this you can enter, store 

and manipulate related data. 

Worksheet 

A page in a workbook is called Worksheet. It  is a collection of cells where you can keep and manipulate 

the data. By default, each Excel workbook contains three worksheets. But we can add as many 

worksheets  as the memory capacity of our computer. You can switch between worksheets by clicking 

on the worksheet tab on the bottom of the Excel window 

Adding, Deleting and Renaming Worksheets 

To add a new worksheet, click on the ‘Insert Worksheet button’ available next to the last worksheet 

tab. A new blank worksheet will be created.  Alternatively, you can right click on any sheet tab and 

select "Insert" from the menu. Pressing of ‘Shift+F11’ buttons also inserts a new sheet. 

To delete an existing sheet, right click on the sheet tab of the desired sheet and select ‘Delete’ from 

the menu. 

By default excel sheets are name as ‘Sheet1’, ‘Sheet2, and so on. To change the name of a worksheet 

right click on a sheet tab, select "rename" and type in a new name followed by the Enter key. 

Rows 

A row is the range of cells that go horizontally in a worksheet.  Rows are identified by numbers like 1, 2, 

3 and so on. Excel 2007 contains 10,48,576 rows in a worksheet. 

Columns 
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SPREADSHEET 



Download from     www.alrahiman.com / www.hsslive.in Page 2 

 

A column is the range of cells that go vertically in a worksheet.  Columns are identified by letters like A, 

B, C  and so on. When it reaches Z, the next columns are identified as AA, AB, AC and so on. Thus in 

Excel 2007 the last column is labeled as ‘XFD’ i.e.; 16,384 columns in a worksheet. 

Cells 

Each rectangular box in a worksheet is referred to as a cell. In other words a cell is the intersection 

point of a column  and   row. Data entered into Excel is always stored in a cell.  

To keep track of where data is stored, each cell has a cell reference consisting of the column letter and 

row number of where the cell is located. 

Range 

Range is a group of more than one cell. Ranges are identified by the cell references of the cells in the 

upper left and lower right corners of the range. These two references are separated by a colon ( : ) 

which tells Excel to include all the cells between these start and end points. For example, the range  

D1:E10 includes a block of 20  cells starting from D1 and ending to E10. 

Cell Reference 

To identify the location  of a cell, a reference is given to a cell. It is also referred to as Cell Address. A 

cell reference or cell address consists of the column letter and row number that intersect at the cell's 

location. 

Eg.  a) The cell in the first column and first row is referred as ‘A1’ 

 b) The cell in the 5th column and 10th row is referred as ‘E10’ 

 c) The cell in the 27th column and 45th row is referred as ‘AA45’ 

Relative, Absolute and Mixed Cell Reference  

Normally, when a formula or function from one cell is copied to another, the references given in the 

formula or function automatically changes to suit the new locations. For example in the cell C1, we 

have given a formula as ‘=A1+B1’ to add values in A1 and B1. If we copy the formula to C2, the formula 

is converted as ‘=A2+B2 ’. This type of reference is called Relative Reference. 

 

Unlike relative references, absolute references do not change when copied to another location. You 

can use an absolute reference to keep a row and/or column constant. An absolute reference is 

designated in a formula by the addition of a dollar sign ($). It can be assigned to the column reference, 

the row reference, or both. Eg. The formula =$A$1+$B$1 will not change its references if we copy the 

formula to any part of the worksheet. 

 

If we assign the constant reference either for column or for row, it is called Mixed Reference. Egg. The 

cell reference $A1, makes the column A constant, but the row 1 changes according to the new location. 

In the same way the reference A$1, makes the row constant, but the column reference relative. 
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Naming a Range 

We understood that Range is a block cells and it is referenced by a Range Reference. The range 

references are used in many formulas for calculations relating with these ranges. But it is difficult to 

remember the reference of range. In excel, we can assign suitable and memorable names for the 

ranges and these names can be used in instead of complicated range references in the formulas and 

functions. 

Consider the following example. Here the scores obtained by a commerce student in his for subjects 

are given in the range C2:C7. To get the total scores in the cell C8, we have to give a formula in C8 as ‘= 

SUM(C2:C7)’. But it is difficult to remember this range reference. Hence we named the range as 

‘Marks’. Then we can use the formula in C8 as ‘=SUM(Marks)’. 

 

 

Steps for Naming a Range 

1. Select the range of cells, that we want to assign name 

2. Click on the Ribbon tab named ‘Formula’ 

3. Click on ‘Define Name’ under Defined Names Group 

4. Then a Dialogue box will be appeared as given below. In this give a suitable name for the range 

in the box labeled as Name. Against the box labeled as ‘Refers to’, the reference of range that 

we selected is displayed. We don’t have change this reference, since we have selected the 

correct range in the beginning. Then pressing OK button will assign the name for the selected 

range.  
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Alternatively after selecting the required range, just right click on the selected range and select ‘Name 

a Range’ from the popup menu. This will bring the New Name dialogue box directly. 

Illustration 

Prepare a table as shown below. Assign suitable names to the ranges which consist of Sales and Sales 

Returns and find the Total Sales, Total Sales Returns and Net Sales of the year by applying assigned 

names in formulas. 

 

 
 

Procedure :- 

1. Open a new excel worksheet 

2. Enter labels for column headings as Quarter, Sales and Sales Returns in the cells A1, B1 and C1 

respectively 

3. Enter Quarter Names – Quarter-1 to  Quarter-4 in the cells A2 to A5 

4. Enter Sales figures of different Quarters as given In table form the cell B2 to B5 

5. Enter Sales Returns figures of different Quarters as given In table form the cell C2 to C5 

6. Enter the label ‘Total’ in cell A6 

7. Enter the label ‘Net Sales’ in cell A7 

8. Select the range B2:B5 and name this range as ‘Sales’ 
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9. Select the range C2:C5 and name this range as ‘Returns’ 

10. Select the cell B6 and name it as ‘TotalSales’ 

11. Select the cell C6 and name it as ‘TotalReturns’ 

12. Select the cell B6 and enter the formula ‘ =sum(Sales)’ 

13. Select the cell C6 and enter the formula ‘ =sum(Returns)’ 

14. Select the cell C7 and enter the formula ‘ =TotalSales-TotalRetuns’ 

(Answers : Total Sales – Rs.191500, Total Returns-Rs.20100, Net Sales-Rs. 171400) 

Basic and Derived Values  

If we directly enter a value or piece of data in a cell, it is called Basic Value. If the data in a cell is 

generated by an arithmetical expression or as the result of a function or formula, it is called derived 

value.  

Eg. We entered Basic Salary in A1, DA in A2, HRA in A3 and the formula =A1+A2+A3 in the cell A4 to get 

Gross Salary. Here Cells A1, A2 and A3 has Basic Values, whereas, A4 has Derived Value.  

Navigation through the Sheet 

We locate any cell by use a mouse click on the desired cell. We can navigate to unseen portion of the 

screen by using Vertical and Horizontal Scroll Bars. Below is given the important Key Board Short Cuts 

to navigate around the sheet.  

 

Excel Navigation Keys 

Down Arrow / Enter Key Moves One Cell Down 

Up Arrow Moves One Cell Up 

Left Arrow Moves One Cell Left 

Right Arrow / Tab Key Moves One Cell Right 

Home Moves to the beginning of Row 

CTRL + Home First Cell of Worksheet (A1) 

CTRL + Down Arrow Moves to First / Last filled cell in the column 

CTRL + Up Arrow Moves to Last / First filled cell in the column 

CTRL + Right Arrow Moves to First / Last filled cell in the Row 

CTRL + Left Arrow Moves to Last / First filled cell in the Row 

Page Up Moves one page up 

Page Down Moves one page Down 
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Labels 

In spreadsheet programs, a label is any descriptive text placed in a cell. It consists of Alphabets and 

Special Characters. Labels can’t be used for mathematical operations. For example in an employee 

database the First Name, Middle Name, Last Name, Address etc can be labels, because these are not 

used for any mathematical operations. 

Formula 

Formulas are self-defined instructions entered in cell for performing calculations. Formula should begin 

with an ‘= ‘ sign. After entering the formula in a cell, we can see only the result of the formula in the 

cell. To see the formula again, we have to double click on the cell or just click on the cell and see the 

formula bar on the top of the window. 

Functions 

A function is a pre-set formula which can be written directly into a cell, to display an outcome. Excel 

comes with pre-loaded functions. The syntax always includes an initial operator and a pair of round 

brackets which enclose the arguments of the function. Eg : Sum( ), Avg( ), Max( ) 

For example:  

=Sum(A1:A5) gives the total of the figures in the range 

=Avg(A1:A5) gives the average value of the figures in the range  

=Max(A1:A5) gives the Maximum value from the figures in the range 

  

Excel 2007 has thousands of pre-defined functions. But we will study the important functions under 

the following six heads. 

1. Date and Time Function 

2. Mathematical Function 

3. Text Manipulation Function 

4. Logical Functions 

5. Lookup and Reference Function 

6. Financial Function 

 

Date and Time Function 

Accounting is much related with the Dates and Times. Transactions are recorded and analysed on the 

basis of its date and time of occurrences. Excel takes 01/01/1900 as a base for calculating the dates. It 

assigns a serial number for each date taking 01/01/1900 as 1, 02/01/1900 as 2 and so on. 

Now we are discussing the four important functions which may be useful in accounting operations. 

These are:- 

Today( )  
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Syntax =SUM(Number1, Number2……Number255) 

The function ‘=Today( )’ in a cell gives the current date in that cell. For example, if we give the today() 

function in cell on a computer on 2015 July 1, the cell displays the result as 01/07/2015. Excel assumes 

this date from our computer’s system date. If the system date is wrong, this will give wrong result. 

In addition, to display the Date the cell’s format should be Date or General. Otherwise it will give the 

serial number of the date. In the above example, if the cell’s format is ‘Text’, the Today() function will 

give the result as 42186. That means 42,816th day from 01/01/1900. 

Now( ) 

It is a similar function of Today(). But this function includes the current time also with the date. For 

example, at 10.30 am in the morning of 2015 July 20, the result of this function is displayed as 

20/07/2015 10:30 

Day(Serial_number) 

 This function returns the day of a date, represented by a serial number. The day is given as an integer 

ranging from 1 to 31. For example if A1 = 23/07/2015, the Day(A1) will result in 23. Because it is the 

23rd day of the month 

Month(Serial_number).  

This function returns the serial number of the month. It ranges from 1 to 12. For example in the above 

case Month(A1) returns 7, i.e. the 7th month 

Year(Serial_number)  

This function returns the serial number of the year. It ranges from 1900 to 9999. For example in the 

above case Year(A1) results in 2015. Ie; the 2015th year. 

DATEVALUE(date_text)  

This function is helpful in cases where a worksheet contains dates in a text format that you want to 

filter, sort, or format as dates, or use in date calculations. For example the cell ‘A2’ contains the value 

‘15/01/2015’ but the cell format is ‘Text’. So we can’t use this cell for the operations related to dates. 

But the function DATEVALUE(A2) in another cell converts this as date 15/01/2015 and the basis of this 

cell we can make date based operations. 

Mathematical Function 

We are now going to discuss some of the important mathematical functions, which are essential for 

business applications. They are :- 

SUM( ) 

The SUM function adds together a supplied set of numbers or numbers in a given range and returns 

the sum of these values.  
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Syntax =SUMIF(range, criteria, [sum_range]) 

 

 

 

Illustration 

 

1 =Sum(12,20,18,10) Adds up the 4 numbers given in brackets, separated by commas 

2 =Sum(D1:D10) Adds up values given in the range D1 to D10 

3 =Sum(F5:G20, R40:T50) Adds up values in two non adjacent ranges separated by comma 

4 =Sum(Basic, DA) Adds up values given in two named ranges separated by comma 

SUMIF( ) 

SUMIF function adds all numbers in a range of cells, only if it meets the given criteria 

 

 

In the above syntax 

 

Range = The range of cells that you want to apply the criteria against. 

Criteria   = The criteria used to determine which cells to add. 

Sum_range  = It is the cells to sum. It is optional. If this parameter is omitted, it uses range as 

the sum_range. 

Illustration: 2 

In the following table we are given the values of Assets and its depreciation for the year 2015 
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Syntax =Round (number, num_digits) 

1 =SUMIF(A2:A7, “>80000”, B2:B7) 
Adds up the depreciations of only those assets which 

is more than Rs.80000 ( Result is 8,150) 

2 =SUMIF(A2:A7, “75000”, B2:B7) 
Adds up the depreciations of only those assets which 

is valued exactly Rs.75000 ( Result is 5,400) 

3 =SUMIF(A2:A7, “<60000”) 
Adds up the values of Assets which is less than Rs.60,000 

(Result is 85,000) 

4 =SUMIF(B2:B7, “>4000”) 
Adds up the depreciation values which  is more than Rs. 

4,000 ( Result will be Rs.4500) 

 

In the first two cases we are using the optional Sum_range. i.e.; evaluation is made on one range and 

on this basis calculation is made on another range. 

In the last two cases the optional Sum_range is excluded. So in these cases evaluation and calculation 

are made on the same range. 

ROUND( ) 

The ROUND function rounds a number to a specified number of digits following normal rounding rules, 

i.e.; round down if the decimal portion is < 5, and round up if the decimal portion is ≥ 5. 

 

 

 

In the above syntax 

number = The number that you want to round. 

num_digits = The number of digits to which you want to round the number. 

 

If you make the num_digits argument a positive value, Excel rounds the number to the specified 

number of decimal places. If you enter the num_digits argument as a negative number, Excel rounds 

the number to the left of the decimal point 

 
Num_digits 

Argument 
�   – 3   – 2 –1 0 1 2   3    � 

Rounds to Nearest 1000 Nearest 100 Nearest 10 Nearest 1 1 Decimal 2 Decimal 3 Decimal 

 

 

Examples 

 

Formula Description Result 

=ROUND ( 528.654,0 ) Rounds to the nearest integer 529 

=ROUND ( 32.654,1 ) Rounds  the first decimal number to the nearest 32.7 

=ROUND ( 185.9214,2 ) Rounds  the second decimal number to the nearest 185.92 

=ROUND ( 5.1478,3 ) Rounds  the third decimal number to the nearest 5.148 

=ROUND ( 412.654,-1 ) Rounds to nearest 10 410 

=ROUND ( 85.8156,-2 ) Rounds to nearest 100 100 

=ROUND ( 2795.285,-3 ) Rounds to nearest 1000 3000 
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Syntax =Roundup (number, num_digits) 

Syntax =Rounddown (number, num_digits) 

In excel there are another two round functions which behave in the same way but with slight differences. 

They are ROUNUP and ROUDDOWN functions. 

 

ROUNDUP() 

The ROUNDUP function always round a number to upward, without considering the value next to the 

rounding digit. If the number in rounding position is more than zero, it is rounded to the next. Eg. 

=Roundup(85.462, 2) results in 85.47. Instead, if we use the formula =Round(85.462,2), the result will 

be 85.46, because the digit in the third decimal place is less than 5. 

ntax 

 Examples 

Formula Description Result 

=ROUNDUP ( 25.314,0 ) Rounds up to the next integer 26 

=ROUNDUP ( 412.424,1 ) Rounds up to one decimal number  412.5 

=ROUNDUP ( 525.6432,2 ) Rounds up to two  decimal number  525.65 

=ROUNDUP ( 32.6425,3 ) Rounds up to three decimal number 32.643 

=ROUNDUP ( 882,-1 ) Rounds up to the next 10 890 

=ROUNDUP ( 1228,-2 ) Rounds up to the  next 100 1300 

=ROUNDUP ( 1825,-3 ) Rounds up to the next 1000 2000 

 

ROUNDDOWN() 

 

The ROUNDDOWN function always round a number to downward, without considering the value next 

to the rounding digit. Eg. = Rounddown(125.675, 1) results in 125.6. Instead, if we use the formula 

=Round(125.675, 1), the result will be 125.7, because the digit in the second decimal place is more than 

5. 

 

 

 

  

Examples 

Formula Description Result 

=ROUNDDOWN ( 125.64,0 ) Rounds down to the next integer 125 

=ROUNDDOWN ( 824.972,1 ) Rounds down to one decimal number  824.9 

=ROUNDDOWN ( 667.542,2 ) Rounds down to two  decimal number  667.54 

=ROUNDDOWN ( 96.3657,3 ) Rounds down to three decimal number 96.365 

=ROUNDDOWN ( 656,-1 ) Rounds down to the next 10 650 

=ROUNDDOWN ( 568,-2 ) Rounds down to the  next 100 500 

=ROUNDDOWN ( 4486,-3 ) Rounds down to the next 1000 4000 
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Syntax =Count (Value1, Value2, Value3…..) 

           

           

  D 

 

 

 

COUNT( ) 

The COUNT function will count cells that contain numbers or count the numbers given in the 

arguments separated by commas 

 

 

Eg:  =Count(25,38,450,365,12)     Results 5 

 =Count(A1:A10) gives the count of cells in the range A1 to A10, that contain numbers 

Illustration 3 

 Have a look on the table given below, which is occupies the range A1:E4, consisting of 20 cells. It 

contains different types of data and also some blank cells. 

 

Here, the formula ' =Count(A1:E4) ' will give the result as 7. Because out of these 20 cells, only 7 cells 

contain numbers. 

Except COUNT function excel provides three other Count functions, which are more useful in 

applications. They are CountA, CountBlant and CountIf 

 

COUNTA()  

The COUNTA function counts the number of cells that contain any type of data. In other words it 

counts the number of cells that are not empty in a range. The cells that contain formula, but the result 

as empty (" ") is also counted here. 

By taking table given above, the formula ' =Counta(A1:E4) ' gives the result as 14. Because out of the 20 

cells 14 cells are filled with any type of date. The nature of data contained in the cell is not a matter 

here. 

In short : -  

Round ()    -  Rounds to the Nearest 

Roundup()    -  Rounds to Upward 

Rounddown() - Rounds to Downward 
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Syntax =Countif 

COUNTBLANK() 

COUNTBLANK function counts the number of cells which are empty in a range. It is an opposite 

function of COUNTA.  A cell that contains form

In the above example,  the formula =Countblank(A1:

COUNTIF() 

COUNTIF function is used  to count the number of cells that meet a criteri

number, expression, cell reference, or text string. For example, you can use a number like 32, a 

comparison like ">32", a cell like B4, or a word like "apples".

 

 

Based on the above table, the formula :

 

 

 

 

Illustration 

In this illustration we are going to study the working of the functions 

by preparing a Time Table sheet 

allotted to each subject, total periods allotted and periods remains to be allotted instantly while 

entering the data. Follow the procedure given below to do this

 

Procedure 

1) Prepare the following struc

below will make the experiment easier)

 

=Countif(A1:E4, "Orange")  gives the result 2, because ‘Orange’ occurs 2 times in the table

=Countif(A1:E4, "White")  gives the result  3, because ‘White’ occurs 3 times in the table

=COUNTIF(A1:E4, ">200") gives the result 4, because there are only 4 items which is more than 200

=COUNTIF(A1:E4, "<100") gives the result 1, because 58 is the only value, which is less than 100

/ www.hsslive.in 

=Countif (range, criteria) 

COUNTBLANK function counts the number of cells which are empty in a range. It is an opposite 

A cell that contains formula is not treated as empty, even if its re

In the above example,  the formula =Countblank(A1:E4) results 6 

to count the number of cells that meet a criteria. The criteria can be a 

reference, or text string. For example, you can use a number like 32, a 

comparison like ">32", a cell like B4, or a word like "apples". 

Based on the above table, the formula :- 

In this illustration we are going to study the working of the functions CountA, CountBlank

by preparing a Time Table sheet of your class. On this sheet we must get the number of periods 

allotted to each subject, total periods allotted and periods remains to be allotted instantly while 

Follow the procedure given below to do this 

Prepare the following structure in a new excel sheet. ( Using the same range of cells as given 

below will make the experiment easier) 

gives the result 2, because ‘Orange’ occurs 2 times in the table

=Countif(A1:E4, "White")  gives the result  3, because ‘White’ occurs 3 times in the table

gives the result 4, because there are only 4 items which is more than 200

gives the result 1, because 58 is the only value, which is less than 100

Page 12 

COUNTBLANK function counts the number of cells which are empty in a range. It is an opposite 

is not treated as empty, even if its result is empty. 

a. The criteria can be a 

reference, or text string. For example, you can use a number like 32, a 

CountBlank and CountIf 

On this sheet we must get the number of periods 

allotted to each subject, total periods allotted and periods remains to be allotted instantly while 

( Using the same range of cells as given 

 

gives the result 2, because ‘Orange’ occurs 2 times in the table 

=Countif(A1:E4, "White")  gives the result  3, because ‘White’ occurs 3 times in the table 

gives the result 4, because there are only 4 items which is more than 200 

gives the result 1, because 58 is the only value, which is less than 100 
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Syntax =Text (value, format_text) 

 

2) After preparing the structure, select the range B3 : K7 ( the area in which we are going to enter the time 

table)  and assign the range a suitable name. Eg; 'periods'. It is helpful for giving reference in the 

formulas. 

3) Now, select the cell B10 and enter the formula given below to count the number of periods allotted to 

English  

 =countif(periods,"Eng") 

Range name can be used as such. But remember to enter the subject name in quotes.  

4) Thus enter the formula to count the occurrences of other subjects in the respective cells.  

( Alternatively, after entering the formula in B10, you can copy it to the columns of other subjects by 

dragging the fill handle to the right. Then double click on each cell and change the subject name "Eng" to 

other subjects such as "Lan", "BS", "Acc", "CA", and "Eco" respectively. 

5) Select the cell K9 and enter the following formula to count cells that contain data 

 =counta (periods) 

6) Select the cell K10 and enter the following formula to count the blank cells 

 =countblank(periods) 

7) Then start entering your time table. See what is happening to the formula results. For example, if you 

first enter 'Eng' in any column the Periods below 'Eng' is shows as '1' , count of filled periods also shows 

as '1' and the unfilled periods is reduced from '20' to '19' 

Text Manipulation Function 

Text() 

Text Function is used to convert a numeric value to a string. This function comes quite useful when you 

want to display numbers in a more readable format or in such a format that makes more sense. 

Another situation where Text Formula can be used is while combining numbers and text strings 

together. 

 

Here, 

Value = specifies the number that you wish to convert to text. 

format_text = specifies the format according to which the conversion is to be done. Please 

note that ‘format_text’ should always be enclosed in quotation marks 

 

To  display the decimal places of numbers in different ways the following criterias are used 

 

To display  As  Use this format  

1234.59 1234.6 "####.#" 

8.9 8.900 "#.000" 

0.631 0.6 "0.#" 
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Syntax =Concatenate (text1, [text2], ...) 

To  display the dates in different ways the following criterias are used 

 

To display  As  Use this format  

Months  1–12 "m" 

Months 01–12 "mm" 

Months Jan–Dec "mmm" 

Months January–December "mmmm" 

Months J–D "mmmmm" 

Days 1–31 "d" 

Days 01–31 "dd" 

Days Sun–Sat "ddd" 

Days Sunday–Saturday "dddd" 

Years 00–99 "yy" 

Years 1900–9999 "yyyy" 

 

Examples  

Formula   Result 

=Text (12/04/2015, “mm”)   04 

=Text (12/04/2015, “ddd”)   Sun 

=Text (12/04/2015, “yyyy”)   2015  

=Text(12.247,”#.00”)   12.25 

 

CONCATENATE() 

The Microsoft Excel CONCATENATE function allows you to join 2 or more strings together. The item can 

be a text value, number, or cell reference 

 

 

For example 

= Concatenate("Good","Morning") give the result  "GoodMorning" 

Here there is no space between "Good" and "Morning". So in order to put a space we should us a 

space in quotes between these two texts. 

So the formula  = Concatenate("Good", " ", "Morning") gives the result "Good Morning" 

 

Have a look on the following table and view the results of the formulas 
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Syntax  =IF(logic_test, value_if true, value_if_false) 
 

 

 

Formula Result 

=Concatenate(A1," ", B1," ",C1) Today is Holiday 

=Concatenate(A2,B2) 500250 

=Concatenate(A2,"-",B2) 500-250 

=Concatenate(A3," ",B3," ",C3) Mohan Kumar Mishra 

=Concatenate("My Total Mark is-",B2) My Total Mark is-250 

=Concatenate("The Price of Book is ",B2," Rupees") The Price of Book is 250 Rupees 

 

We can do the same function by using ampersand sign (&) instead of Concatenate function. 

Ie; ' =A1&" "&B1&" "&C1 '  gives the result as  "Today is Holiday" 

 ' = "The Price of Book is "&B2&" Rupees" gives the result as   "The Price of Book is 250 Rupees" 

 

Logical Functions 

A logical function can return only one of two values: TRUE or FALSE 

If 

The IF function is one of the most popular and useful functions in Excel. IF function asks Excel to test a 

condition and to return one value if the condition is true, and another value if the condition is false. 

 

 

Here,  

logical_test  (required) = The condition you want to test.  

value_if_true (required) = The value that you want returned if the result of logical_test is TRUE.  

value_if_false (optional) = The value that you want returned if the result of logical_test is FALSE. 

 

The operators in the logical_test of the IF function may be 

=  Equals to 

<>  Not Equals to 

>  Greater than 
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Syntax =IF(Condition_1,Value_if_True_1,IF(Condition_2,Value_if_True_2,Value_if_False_2)) 
 

>=  Greater than or equal to 

<  Less than 

<=  Less than or equal to 

 

Examples 

 

 

1) =if(B1="Male","He","She") Results – "He" 

2) =if(B2>=18,"Adult","Child")    Results – "Child" 

3) =if(B3<20000,B3*10%,B3*20%)  Results – 5000) 

4) =if(B4>=18,"Passed","Failed")   Results – "Passed" 

5) =if(B5>300000,"Rich","Poor")    Results – "Rich" 

6) =if(B3<50000,100,50)  Results – 100 

7) =if(B4<>30,1,2) Results -1 

 

Nested if 

 

The IF function can be nested, when you have multiple conditions to meet. The FALSE value is being 

replaced by another If function to make a further test.  

 

Here, 

Condition_1 Refers to the condition used in the first IF. 

Value_if_True_1 The result if first IF statement is True. 

Condition_2 The condition used in the second IF. The second IF will be started only when the 

First IF statement results a False value. 

Value_if_True_2 The  result if second IF statement is True. 

Value_if_False_2 The result if second IF statement is False. 

 

For example, look at the formula below. 
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=if(A1=1,"Average",if(A1=2,"Good","Very Good") 

At first the formula checks the first condition i.e. whether the cell contains the value 1 or not.  

If it contains '1' the condition becomes true, it gives the result 'Average" and stops the formula.  

But if the cell A1 does not contain the value '1' the condition results FALSE. Then instead of giving a 

value for the FALSE, it starts checking another condition i.e. whether it contains the value 2.  

If the second condition satisfies it gives the result "Good". Otherwise it gives the result "Very Good". 

In this way we can nest up to 64 ifs in Excel 2007 

 

Example : 

Suppose a company charges surcharge on its bills as follows 

 Bill Amount (Rs)          Surcharge (Rs) 

 Upto Rs. 5000 25 

 5001 – 10000 30 

 10001 – 20000 40 

 20001 and above 75  

Assuming that bill amount is given in the cell, the following formula will calculate the amount of 

surcharge by nesting three IF statements as follows 

=if(A1>20000,75,if(A1>10000,40,if(A1>5000,30,25))) 

*Remember to close all if statement by putting as many closing brackets at the end of the statement as 

the number of IF Statements 

 

Exercise: 

We know that in grading system the Marks are converted into Grades as follows. 

 Marks  Grade 

 90 – 100 A+ 

 80 – 89  A 

 70 – 79  B+ 

 60 – 69  B 

 50 – 59  C+ 

 40 – 49  C 

 30 – 39  D+ 

 20 – 29  D 

 0 – 19  E  

Assuming that, we are entering a mark in the cell  'A1', try to write a nested if formula in 'B1' to convert 

that mark into Grade.  
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Syntax  =AND(Condition1, Condition2……..) 
 

Hints :  

1) You have to nest 8 Ifs 

2) Remember to put Grades in formula within double quotes. Eg. "A+" 

3) If you use 'greater than' (>) operator, Start from highest to lowest, If using  'Less than'(<), start from Lowest to 

highest 

AND 

AND is another useful logical function in excel. It checks more than one condition at the same time and 

returns TRUE if all the conditions are satisfied. Otherwise it Returns FALSE. 

 

 

Have a look on the following table 

 

 

Here 

=AND(B1>200000, B2>35000)    Returns FALSE  (Because 2nd condition not satisfied) 

=AND(B2<10000, B3>25000)    Returns FALSE  (Because both conditions are not satisfied) 

=AND(A1="Sales", B3<60000)    Returns TRUE  (Because both conditions are satisfied) 

=AND(A2="Gross Profit", B2=32000, B3<25000)   Returns FALSE (Because one condition is not satisfied) 

 

Thus in Excel 2007, we can check upto 255 conditions in AND Function.  

AND Function will be more useful when it is combined with IF Function. Consider the following 

examples based on the above table. 

=if(AND(B1>250000,B2<50,000,B3=24000),"All Conditions Satisfied","Not Satisfied") 

In the above formula the Logic_test part of the IF formula replaced by an AND function that checks 

three conditions. Ie.  

(1)  Is the value in B1 is greater than 250000  

(2)  Is the value in  B2 is less than 50000 

(3)  Is the value in B3 is equal to 24000 

If all the three conditions are satisfied, the AND Function returns TRUE and the if function returns the 

value_if_true and it gives the result. In the above formula, the result is "All Conditions are Satisfied" 

because all the three conditions are fulfilled here. If any of the AND function is not satisfied, the result 

will be "Not Satisfied" 
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Syntax  =LOOKUP(lookup_value, lookup_range, [result_range] ) 
) 

Lookup and Reference Function 

Excel's Lookup and Reference Functions can be used to simplify finding specific entries in a data table. 

Three important lookup and reference functions viz. LOOKUP, VLOOKUP, HLOOKUP functions are 

discussed below 

 

LOOKUP 

The LOOKUP function is used to search one column of data and find data in the corresponding row. For 

example, in a table containing three values Adm.No, Candidate Name and Mark, you can search a 

particular Adm.No  and retrieve the Name or Mark of that particular Candidate. 

 

 

  

 

Here,  

Lookup_value The value to search for in the lookup_range. 

Lookup_Range A single row or single column of data that is sorted in ascending order. The 

LOOKUP function searches for value in this range. 

Result_range  It is a single row or single column of data that is the same size as the 

lookup_range. The LOOKUP function searches for the value in the lookup_range 

and returns the value from the same position in the result_range. 

 

 

 

 

 

 

 

Example : 

Examine the following worksheet. It contains a table which has three columns viz. Adm.No, Candidate 

Name and Marks. 

Here the formula  =Lookup(3101,A2:A11,B2:B11)  retrieves "APOORVA" as the result.  

That means at first the formula searches for the value 3101 in the range  A2:A11. Then it brings the 

corresponding value from the range B2:B11.  

 

• If the LOOKUP function can not find an exact match, it chooses the largest value in the 

lookup_range that is less than the lookup_value. 

• If the lookup_value is smaller than all of the values in the lookup_range, then the 

LOOKUP function will return  the error #N/A. 

• If the values in the LOOKUP_range are not sorted in ascending order, the LOOKUP 

function will return the incorrect value. 
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Syntax =VLOOKUP( lookup_value, table_array, col_index_number, 

range_lookup ) 
) 

 

=Lookup(3101,A2:A11,C2:C11) gives the result  - 581 

=Lookup(3134,A2:A11,B2:B11) gives the result "NAFEESA" 

=Lookup(3100,A2:A11,B2:B11) gives the result "JIBI GEORGE" (Since lookup value 3100 is not in the list 

it takes highest value lower than 3100 into consideration. Here it is 3092) 

=Lookup(3150,A2:A11,C2:C11) gives the result -524 

=Lookup(2560,A2:A11,B2:B11) results in an error #NA (Because the lookup value is smaller than the 

lowest item in the range. 

 

VLOOKUP 

The VLOOKUP function performs a vertical lookup by searching for a value in the left-most column of 

the table and returning the value in the same row in the index_number position. 

 

 

 

Lookup_Value The value to search for in the first column of the table. 

Table_array Two or more columns of data that is sorted in ascending order. 

Col_index_number The column number in table from which the matching value must be returned. 

The first column is 1. 

Range_lookup In this criteria, you can give either FALSE or TRUE. If you are given FALSE it will 

search for an exact match. If an exact match is not found the formula will retun 

an error #NA.  

 If you are given TRUE or not given anything, it will search for an approximate 

match. That means if an exact match is not found it will search for  largest value 

that is less than Lookup_value. If the first column is not sorted in ascending 

order, it will give wrong result in this case. 
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Syntax =HLOOKUP( lookup_value, table_array, row_index_number, 

range_lookup ) 
) 

 

Below is given a table of Student Details 

 

 

 

=Vlookup(2775,A2:E10,2,False) will give the result – "FARISHA.M.K" 

Here this formula will search for the value '2775' in the first column of the table, which Is arranged in 

the range A2:E10. Then it retrieves corresponding value of that row in the 2nd column ie. the Name of 

Pupil. 

In the same manner, the formula =Vlookup(2775,A2:E10,3,False) retrieves the result – 'OBC'  ie. the 

value in 3rd Column. 

More Examples:- 

Formula  Result 

=Vlookup(2711,A2:E10,4,False)  13-02-1998 

=Vlookup(2580,A2:E10,5,False)  HARIDASAN. A.P. 

=Vlookup(2680,A2:E10,2,False)  AASHIKA NASRIN.T 

=Vlookup(2711,A2:E10,3,False)  ST 

Hlookup 

HLOOKUP function performs a horizontal lookup by searching for a value in the top row of the table 

and returning the value in the same column based on the index_number 
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Lookup_Value The value to search for in the first row of the table. 

Table_array Two or more rows of data that is sorted in ascending order. 

Row_index_number The row number in table from which the matching value must be returned. The 

first row is 1. 

Range_lookup In this criteria, you can give either FALSE or TRUE. If you are given FALSE it will 

search for an exact match. If it is TRUE or not given anything, it will search for 

an approximate match as in the case of VLOOKUP 

 

Below is given a table of Product Details. Study the table and analyze the following formula results 

 

 

 

                       Formula             Result                      . 

=Hlookup(321,A1:F5,2,False)  Bag 

=Hlookup(265,A1:F5,5,False)  580 

=Hlookup(458,A1:F5,3,False)  1.5 

=Hlookup(352,A1:F5,2,False)  Tiffin Box 

 

Financial Functions 

The excel financial functions have been made available to execute a variety of financial calculations. 

The important among are discussed below:- 

ACCRINT 

The ACCRINT function is useful in calculating the accrued interest for a security that pays periodic 

interest.   

To understand the meaning of Accrued Interest, let see an example 

On 1.Mar.2015, Mr.Sreenivas has invested Rs.5000 in a security having compound interest @10% 

annually.  The next interest date of the security is 31-Dec-2015. But meanwhile on 24-April-2015 he sold 
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Syntax =ACCRINT(issue, first_interest, settlement, rate, [par], frequency, 

[basis])) 

the security to Mr.Sumesh. On 31
st

 Dec 2015, Mr.Sumesh will get interest for the 9 months. But 

Mr.Sreenivas was the holder of the security for 53 days  and hence Mr.Sumesh has to pay interest 

receivable for these days to Sreenivas, along with the market value of the security. This interest is 

calculated as follows:- 

5000 X 
��

���
 x 

��

���
 =  Rs. 73.61111 

 

The ACCRINT Function helps to calculate accrued interests in such situations 

  

 

 

issue  The date the security is issued. 

first_interest The date when the initial interest is paid. 

settlement  The settlement date of the security. 

rate  The annual interest rate or coupon when the security was issued. 

par  The par value of the security. 

frequency  The number of coupon payments per year: (1 = annual, 2 = semi annual (default), 

4 = quarterly) 

basis  The type of day counting to use: 

0 = US 30/360 (default) 

1 = Actual/Actual 

2 = Actual/360 

3 = Actual/365 

4 = European 30/360 

calc_method  The start date for the accrued interest: 

   True = start accruing interest from the issue date 

   False = start accruing interest from the last coupon payment date. 

The example cited above is arranged in a worksheet as given below. 

Here the formula  =ACCRINT(B2,B3,B4,B5,B6,1,0)  simply gives the answer 73.61111 
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Syntax = CUMIPMT( rate, nper, pv, start_period, end_period, type )

CUMIPMT 

Returns the cumulative interest paid on a loan between two dates

rate - The interest rate, per period 

nper - The number of periods over which the loan or investment is to be paid 

pv - The present value of the loan / investment 

start_period - The number of the first period over which the interest is to be calculated 

(must be an integer between 1 and nper) 

end_period - The number of the last period over which the interest is to be calculated 

(must be an integer between 1 and nper) 

type - An integer (equal to 0 or 1), that defines whether the payment is made at the 

start or the end of the period 

  The value 0 or 1 has the following meaning: 

   0   -   the payment is made at the end of the peri

   1   -   the payment is made at the beginning of the period

 

Divide the interest rate by 12 to get a monthly rate. Multiply the years the money is paid out by 12 to 

get the number of periods. 

 

Example: 

A loan Rs. 5,00,000 was taken on 01

monthly installments over 4 years. 

To calculate the interest payable in first 8 months the following formula is used in cell B6

=CUMIPMT(

 

Here the rate is divided by 12 to get monthly rate and the years is multiplied by 12 to get the number 

of payments 
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CUMIPMT( rate, nper, pv, start_period, end_period, type )

 

Returns the cumulative interest paid on a loan between two dates 

The interest rate, per period  

The number of periods over which the loan or investment is to be paid 

ent value of the loan / investment  

The number of the first period over which the interest is to be calculated 

(must be an integer between 1 and nper)  

The number of the last period over which the interest is to be calculated 

ust be an integer between 1 and nper)  

An integer (equal to 0 or 1), that defines whether the payment is made at the 

start or the end of the period  

The value 0 or 1 has the following meaning:  

the payment is made at the end of the period 

the payment is made at the beginning of the period

Divide the interest rate by 12 to get a monthly rate. Multiply the years the money is paid out by 12 to 

A loan Rs. 5,00,000 was taken on 01-01-2013. The annual interest rate is 10%. The loan is repayable in 

monthly installments over 4 years.  

To calculate the interest payable in first 8 months the following formula is used in cell B6

=CUMIPMT(B2/12,B3*12,B1,1,8,0) 

 

 

Here the rate is divided by 12 to get monthly rate and the years is multiplied by 12 to get the number 
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CUMIPMT( rate, nper, pv, start_period, end_period, type ) 
 

 

The number of periods over which the loan or investment is to be paid  

The number of the first period over which the interest is to be calculated 

The number of the last period over which the interest is to be calculated 

An integer (equal to 0 or 1), that defines whether the payment is made at the 

the payment is made at the beginning of the period 

Divide the interest rate by 12 to get a monthly rate. Multiply the years the money is paid out by 12 to 

2013. The annual interest rate is 10%. The loan is repayable in 

To calculate the interest payable in first 8 months the following formula is used in cell B6 

Here the rate is divided by 12 to get monthly rate and the years is multiplied by 12 to get the number 
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Syntax 

Syntax 

PV() 

The Excel PV function calculates the 

payments. 

 

 

 

 

rate  -  The interest rate, per period

nper  -  The number of periods for the lifetime of the annuity or investment

pmt  -  An optional argument 

argument is omitted, the [fv] argument must be supplied)

[fv]  -  An optional argument that specifies the future value of the annuity, at the end of 

nper payments. if the [fv] argument is omitted, it takes 

[type]  -  An optional argument 0 or 1, that defines whether the payment is made at the 

start or the end of the period.( 0 = End, 1 = Start)

 

The example below shows the Excel PV function used to calculate the Present value of an 

of Rs.2,000 p.a for a period of 4 years. The interest is 10% per year and each payment is made at the 

start of the year. 

 

Here Present Value is calculated as =PV(B1,B2,B3,B4,B5)

 

FV() 

The FV function calculates the future value of an investmen
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= PV( rate, nper, pmt, [fv], [type] ) 

=FV(rate,nper,pmt,[pv],[type]) 

The Excel PV function calculates the Present Value of an investment, based on a series of future 

The interest rate, per period 

The number of periods for the lifetime of the annuity or investment

An optional argument that specifies the payment per period (if the pmt 

argument is omitted, the [fv] argument must be supplied) 

An optional argument that specifies the future value of the annuity, at the end of 

nper payments. if the [fv] argument is omitted, it takes on the default value 0.

An optional argument 0 or 1, that defines whether the payment is made at the 

start or the end of the period.( 0 = End, 1 = Start) 

The example below shows the Excel PV function used to calculate the Present value of an 

of Rs.2,000 p.a for a period of 4 years. The interest is 10% per year and each payment is made at the 

 

Here Present Value is calculated as =PV(B1,B2,B3,B4,B5) 

The FV function calculates the future value of an investment 
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investment, based on a series of future 

The number of periods for the lifetime of the annuity or investment 

that specifies the payment per period (if the pmt 

An optional argument that specifies the future value of the annuity, at the end of 

on the default value 0. 

An optional argument 0 or 1, that defines whether the payment is made at the 

The example below shows the Excel PV function used to calculate the Present value of an investment 

of Rs.2,000 p.a for a period of 4 years. The interest is 10% per year and each payment is made at the 
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Syntax 

Syntax 

The example below shows the Excel Fv function used to calculate the future value of an investment of 

Rs.2,000 p.a for a period of 4 years. The interest is 10% per year and each payment is made at the 

of the year. 

Here FV is calculated as =FV(B1,B2,B3,B4,B5)

 

NPV() 

Calculates the net present value of an investment by using a discount rate and a series of future 

payments (negative values) and income (positive values).

 

 

 

For example , if interest rate is 10%,  the value of Rs.1000 received after one year is only Rs.909. That 

means if we invest Rs.909 today, we will get Rs.909+10% interest  (Rs.999.9) after one year. Thus the 

value of Rs.1000 receivable after one year can be calculated as the following formula

Illustration 

A company investmens Rs.50000 in a project at the end of this year. It brings inflow of Rs.20000, 32000 

and 28000 respectively at the end of 

Here Net Present Value(NPV) is calculated as =NPV(B1,B2,B3,B4,B5)

PMT() 

The Excel PMT function calculates the constant periodic payment required to pay off  a loan or 

investment, with a constant interest rate, over a specified period.
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=NPV(rate,value1,[value2],...) 

=PMT( rate, nper, pv, [fv], [type] ) 

NPV(rate,value1,[value2],...) 

The example below shows the Excel Fv function used to calculate the future value of an investment of 

Rs.2,000 p.a for a period of 4 years. The interest is 10% per year and each payment is made at the 

 

Here FV is calculated as =FV(B1,B2,B3,B4,B5) 

Calculates the net present value of an investment by using a discount rate and a series of future 

payments (negative values) and income (positive values).  

For example , if interest rate is 10%,  the value of Rs.1000 received after one year is only Rs.909. That 

means if we invest Rs.909 today, we will get Rs.909+10% interest  (Rs.999.9) after one year. Thus the 

000 receivable after one year can be calculated as the following formula

=NPV(10%,1000) 

A company investmens Rs.50000 in a project at the end of this year. It brings inflow of Rs.20000, 32000 

and 28000 respectively at the end of next three years. 

Here Net Present Value(NPV) is calculated as =NPV(B1,B2,B3,B4,B5)

The Excel PMT function calculates the constant periodic payment required to pay off  a loan or 

investment, with a constant interest rate, over a specified period. 
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The example below shows the Excel Fv function used to calculate the future value of an investment of 

Rs.2,000 p.a for a period of 4 years. The interest is 10% per year and each payment is made at the start 

Calculates the net present value of an investment by using a discount rate and a series of future 

For example , if interest rate is 10%,  the value of Rs.1000 received after one year is only Rs.909. That 

means if we invest Rs.909 today, we will get Rs.909+10% interest  (Rs.999.9) after one year. Thus the 

000 receivable after one year can be calculated as the following formula 

A company investmens Rs.50000 in a project at the end of this year. It brings inflow of Rs.20000, 32000 

 

Here Net Present Value(NPV) is calculated as =NPV(B1,B2,B3,B4,B5) 

The Excel PMT function calculates the constant periodic payment required to pay off  a loan or 
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For example: Calculate the monthly payments 

the Number of Monthly Instalaments is 48 with the help of PMT () function

Here PMT is calculated by the formula, =PMT(B1/12,B2,B3)

Data Fill Options 

If you want to copy data in one cell to the adjacent cell

feature  available in excel. Fill handle is a small black rectangle seen in the right bottom of the cell or 

range when it is selected.   

Instead of entering data manually on a worksheet, you can 

direction to copy data to adjacent cells.

displayed. Here the first option copies both data and format, Second option copies formatting only and 

third option copies data only. If we are copying Numbers on more option 'Fill Se

 

  

Normally while dragging down or across, excel copies the same data into the adjacent cells as shown 

above. But in certain cases, excel automatically assumes some series and fills that series into copied  

cells. Eg. Name of Day, Name of Month, Date etc. 

Have a look on the following sheet. In this sheet only the data in the first cell is manually entered and 

while dragging down this with Fill handle, see what
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For example: Calculate the monthly payments of the Bank loan of Rs 10000 for interest rate @ 5% and 

the Number of Monthly Instalaments is 48 with the help of PMT () function. 

 

T is calculated by the formula, =PMT(B1/12,B2,B3) 

If you want to copy data in one cell to the adjacent cells (column or row) you can use the Fill Handle

available in excel. Fill handle is a small black rectangle seen in the right bottom of the cell or 

 

Instead of entering data manually on a worksheet, you can click and drag the Fill Handle in desired 

adjacent cells. After dragging is completed an Auto Fill Options box is 

displayed. Here the first option copies both data and format, Second option copies formatting only and 

If we are copying Numbers on more option 'Fill Series' will be available.

Normally while dragging down or across, excel copies the same data into the adjacent cells as shown 

above. But in certain cases, excel automatically assumes some series and fills that series into copied  

, Name of Month, Date etc.  

Have a look on the following sheet. In this sheet only the data in the first cell is manually entered and 

this with Fill handle, see what is happening. 
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of the Bank loan of Rs 10000 for interest rate @ 5% and 

 

you can use the Fill Handle 

available in excel. Fill handle is a small black rectangle seen in the right bottom of the cell or 

click and drag the Fill Handle in desired 

After dragging is completed an Auto Fill Options box is 

displayed. Here the first option copies both data and format, Second option copies formatting only and 

ries' will be available. 

 

Normally while dragging down or across, excel copies the same data into the adjacent cells as shown 

above. But in certain cases, excel automatically assumes some series and fills that series into copied  

Have a look on the following sheet. In this sheet only the data in the first cell is manually entered and 
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In addition to this we can copy data in a series as we desire, by entering data in two or more cells and 

dragging this to adjacent cells. For example enter '10' in A1 and enter '20' in A2. Then select the range 

A1:A2 and drag it down by clicking on the fill handle. Here we can see that the data are filled down 

with a difference of 10. See the following sheet for similar examples. 
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Fill data through Fill Button. 

Data can be filled in to adjacent cells by using Fill Button available in the  Editing group of Home Tab. 

Here, options are available to fill data Up, Down, Left, Right, series etc. 

Example : 

In cell A1 enter the number 1. Then click on the button Fill in the Editing Group. The following window 

will be appeared. In series select the Columns option, In type select Linear, in step value enter 1 (ie the 

difference between each values) and In stop value enter a number, where to stop the filling the series 

and then press OK. See what is happening 

         Result  ����         

 

Import / Copy data from other sources 

If you have data in an alternative source, you may be able to import it into Excel, instead of having to re-enter all 

the information again.  Depending on the type of data you would like to import, you can select from a number of 

options such as From Access, From Web, From Text, From Other Sources.  We’ll look at one of the most common 

import types – a text file. 

To import data from a text file the following steps are required:- 

1. In order to learn how to import a text file into excel, we must create a sample text file in 

Note Pad. To open Not Pad follow the following sequence 

 Start Button � All Programs � Accessories � Notepad 

                      Then a new blank file is opened.  

2. Here first enter the column headings separated by comas, as given below 
 Eg � AdmNo,Name,Class,Language 
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3. Then enter the data part from the second line onwards. Each value should be separated by comas 

 3125,Ramesh,C2C,Malayalam 

 3251,Najeeb,C2C,Arabic 

 2859,Vincent,C2C,Hindi  

 And so on …. 

4. After completing the entries save the file into any location. The extension of the file will be .txt 

5. Then open a new Excel Worksheet 

6. Select the Data Tab on the Ribbon 

7. On the Data Tab go to 'Get External Data' group and click on the button 'From Text'. 

 

 
 

8. Then a file selection window is opened. Browse for the text file that we have created and click on 

open button. 

9. Then a text import wizard is opened. Please select 'Delimited' under the option 'Original data type' 

(Because we have created a coma delimited file). Then click next 

10. Then the following window is opened. Select the option 'Coma' under Delimiters since we have 

created coma delimited file 

(Instead of giving coma in text file you can give Tab, Semicolon, Space, or any other characters. What 

you have given in the text file is selected here. Because based on this character data is spitted in to 

columns by  excel).   

Then click next button 
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11. Then in the next window, we can select each column in Data Preview window and can assign Data 

Format for each column. Then click 'Finish' Button 

12. On this a new window asks you from which cell the data should be insert. Select the first cell of the 

table in which you want to insert the data and Press 'OK'.  

After inserting the text file given in example, the excel sheet will look like as follows 

 

 
 

 

Data Validation 

Data validation is an Excel feature that you can use to define restrictions on what data can  be entered in a cell. 

You can configure data validation to prevent users from entering data that is not valid. If you prefer, you can 

allow users to enter invalid data but warn them when they try to type it in the cell. You can restrict the entry in  

a cell by restricting to select the data from a drop down list. You can also provide messages to define what input 

you expect for the cell, and instructions to help users correct any errors. 

 

The Data Validation Button is available in Data Tools group of Data tab in Ribbons 

 

 
 

 

The data validation window has three tabs viz.  

Settings : Allow us to restrict the type of data that can be entered in a cell or range. Here you can 

set the validation criteria. The available validation criteria are  

 Any Value, Whole Number, Decimal, Date, Time, Text Length, Custom. 

  If you want to create a drop down list, you should select List in the validation criteria 

• In the source field you can enter the values directly separated by comas (Eg: To 

get a drop down list that includes the course name enter  'Science, Commerce, 

Humanities' in source field )  
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• You can select a range from the workbook (Eg: $A$1:$A$3 ) 

• You can give the name of a range that contains the list. (Eg. Name the range that 

contains Course Name as 'Courses' and enter ' = courses' in source field 

 

Input Message : When the validated cell is selected, we can give a message to the user about the 

data type to be entered. Eg. In a cell that is used to enter bank account number we 

can invoke a message like below 

 

 

 

Error Alert. : If the user enters wrong data against the validated cell, we can alert him by 

displaying error message boxes. There are three types error messages 

 

 

   

  We can customize the heading and error message of error messages. If left 

blank excel will display default error messages  

  

Illustration 

Let us create an Employee details form as below. After that let us validate each cell to which data is entered in 

various manners 
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Select cell B2 and click on Data Validation button. In Settings tab select 'Whole Number' under Allow 

and select between under 'Data' and enter 1 in minimum and 500 in maximum. (That means we can 

enter only digits from 1 to 500 in this cell).  

Then click on 'Input Message' tab and enter 'ID No. Limit' in title and "ID Number should be between 1 

and 500" in input message box.  

Then click on ' Error Alert' tab and select 'Stop' as Style and enter "Invalid ID No." in title and "You have 

entered an invalid ID No. Please Check" in Error Message box. 

Now we have set the Validation Rule, Input Message and Error Alert for the cell B2. In the same way 

set the rules for all the remaining data entry cells as given in the following table. 

Cell Description Validation Settings 
Input Message 

Settings 
Error Alert Settings 

B3 

Set the maximum 

number of text limit as 

50 

Allow : Text Length 

Data : Between 

Minimum : 1 

Maximum :50 

Title : Name of 

Employee 

Input Message : 

Maximum No. 

of Characters 

allowed is 50 

Style : Stop 

Title : Limit Exceeded 

Error Message : 

Maximum characters 

allowed is 50 

B4 

Create a drop down list 

which include Male & 

Female. 

Allow : List 

Source : Male,Female 

Title : Select Sex 

Input Message : 

Select Male or 

Female from 

the Combo Box 

Style : Stop 

Title : Invalid Sex 

Error Message : Sex 

can be only Male or 

Female 

B5 

Create a drop down list 

from a list created 

anywhere in the work 

sheet. Make  a 

Department  list as 

Science, Commerce 

and Humanities and 

name the range as 

'Dept'. 

Allow : List 

Source :  =Dept 

Title : Select 

Department 

Input Message : 

Select 

Respective Dept 

from Combo 

box 

Style : Warning 

Title : New Dept 

entered. 

Error Message : You 

have entered a dept 

which is not in list 
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B6 

Restrict entry of date 

from 01/01/1900 to 

current date 

Allow : Date 

Data : Between 

Start Date : 01/01/1900 

End Date : =today() 

Title  : Enter 

Date of Birth 

Input Message : 

Date should be 

entered in the 

format 

dd/mm/yyyy 

Style : Information 

Title : Invalid Date 

Error Message : You 

have entered an 

Invalid Date 

B7 

Restrict basic pay as 

number between 

20740 to 36140 

Allow : Whole Number 

Data : Between 

Minimum : 20740 

Maximum : 36140 

Title : Basic Pay 

Input Message: 

Basic pay 

ranges from 

20740 to 36140 

Style : Stop 

Title : Invalid Basic Pay 

Error Message : You 

have entered an 

invalid basic pay 

B8 

Restrict PAN Number 

as exactly 10 

characters 

Allow : Text Length 

Data : Equel To 

Length : 10 

Title : PAN No 

Input Message : 

PAN No. may 

have 10 

characters 

Style : Stop 

Title : Invalid PAN 

entered  

Error Message : PAN 

no. should have 10 

characters 

 

After validating cell B2 to B8 test by entering data. You should deliberately enter some invalid data to 

check whether your validation works or not. 

Data Form 

The data form allows you to add, edit and delete records (rows) and display only those records that 

meet certain criteria. Especially when you have wide rows and you want to avoid repeated scrolling to 

the right and left, the data form can be useful. 

 

By default, you can’t find out the Data Form command in Microsoft Excel 2007, because it is not in 

Ribbon. If you want to apply this command, you need to customize the Ribbon: 
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• Step 1: Click the Office Button and Excel Options button in Microsoft Excel 2007 to enter the 

Excel Options window 

• Step 2: Click the Customize button at left bar  

• Step 3: Select the Commands Not in the Ribbon from the Choose commands from drop down 

list 

• Step 4: Find out the Form… item from the command list; 

• Step 5: Click the Add button; 

• Step 6: Click the OK button to finish the customization.  

 

 Then you can see the Form Button in Quick Access Tool bar    

 

Cell Formatting  

Microsoft Excel lets you change many of the ways it displays data in a cell. For example, you can specify 

the number of digits to the right of a decimal point, or you can add a pattern and border to the cell. 

You can access and modify the majority of these settings in the Format Cells dialog box (on the Format 

menu, click Cells). 

To invoke the Format Cells Dialogue box there are three ways 

1) Go to Home Tab, then click on the format Button  available in the group 'Cells', In the drop 

down list Click on 'Format Cells' 

2) Right click on the cell or range, which you want to format and select the menu 'Format Cells' 

3) After selecting the required range or cell, Press Ctrl+1  

 

This Format Dialogue box has Six Tabs viz. Number, Alignment, Font, Border, Fill and Protection. As the 

name of the tab implies each tab serves different areas of Formatting. 
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Number Tab : Allows you to set the data type for a cell or range. Data type may be set as 

General, Number, Currency, Accounting, Date, Time, Percentage, Fraction, 

Scientific, Text, Special, Custom. 

Alignment Tab :  Helps to align the data in a cell horizontally and vertically.  Here you can Shrink 

link long texts to fit in the cell, Wrap Text within a cell and Can merge two or 

more colomns together. You can also set the orientation texts here. 

Font Tab :  Here you can select the Font, set the Font style, Size, Color, Special effects..etc 

of the fonts 

Border Tab : The style of border, border Line thickness, Line color etc are set here 

Fill Tab :  The back ground color of a cell is defined here. Different patterns of back 

ground is available here.  You can also assign different effects to cell back 

grounds in this tab. 

Protection Tab : Use the options on the Protection tab to lock or hide cells before you protect 

the worksheet. 

  Locked    Prevents selected cells from being changed, moved, resized, or 

deleted. Locking cells has no effect until you protect the worksheet. 

  Hidden    Hides a formula in a cell so that it does not appear in the formula bar 

when the cell is selected. If you select this option, it has no effect until you 

protect the worksheet. 

Most of this cell formatting can be done by clicking on the buttons arranged in different groups of  

Home Tab 
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Conditional Formatting. 

Conditional formatting allows you to automatically apply formatting

bars—to one or more cells based on the 

formatting rule. For example, a conditional formatting rule might be: 

color the cell red. By applying this rule, you'd be able to quickly see which cells contain values less than 

2000. 

Format all cells by using a colour scale

Color Scales in Excel make it very easy to visualize values in a range of cells. The shade of the color 

represents the value in the cell. To add a color scale, execute the following steps.

1. Select a range. 

2. On the Home tab, click Conditional Formatting, Color Scales, and click a subtype.

Format cells using Predefined Rules

In excel 2007and higher version, there are some predefined rules to format the cells on the basis of 

some standard conditions. In this we can highlight cells that contains Greater than a specific Value, 

Less than a value, cells that contain values between a 
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Conditional formatting allows you to automatically apply formatting—such as colors

to one or more cells based on the cell value. To do this, you'll need to 

. For example, a conditional formatting rule might be: If the value is less than 2000, 

By applying this rule, you'd be able to quickly see which cells contain values less than 

Format all cells by using a colour scale 

make it very easy to visualize values in a range of cells. The shade of the color 

To add a color scale, execute the following steps. 

2. On the Home tab, click Conditional Formatting, Color Scales, and click a subtype.

                                    

Format cells using Predefined Rules 

2007and higher version, there are some predefined rules to format the cells on the basis of 

some standard conditions. In this we can highlight cells that contains Greater than a specific Value, 

Less than a value, cells that contain values between a range etc. 
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colors, icons, and data 

. To do this, you'll need to set a conditional 

If the value is less than 2000, 

By applying this rule, you'd be able to quickly see which cells contain values less than 

make it very easy to visualize values in a range of cells. The shade of the color 

 

2. On the Home tab, click Conditional Formatting, Color Scales, and click a subtype. 

2007and higher version, there are some predefined rules to format the cells on the basis of 

some standard conditions. In this we can highlight cells that contains Greater than a specific Value, 
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Format cells using custom rules. 

In addition to the pre-defined rules,

formatting can be done with customized rules. 

conditional format click New Rule. The 

Rule dialogue box is displayed.  

By using  this rule you can format cell that contain 

unique values, duplicate values, cells that contain above 

or below average values etc. You can also set format 

rules based on the result  of a formula. 

 

 

 

Formatting a Table 

Microsoft Office Excel provides numerous predefined

format a table. If the predefined table styles don't meet your needs, you can create and apply a custom table 

style 

1. Choose a table style when you create a table

2. On the worksheet, select a range of

3. On the Home tab, in the Styles

 

4. Under Light, Medium, or Dark

5. Tip   Custom table styles are available under 
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rules, conditional 

formatting can be done with customized rules. To add a 

. The New Formatting 

can format cell that contain 

unique values, duplicate values, cells that contain above 

or below average values etc. You can also set format 

rules based on the result  of a formula.  

Microsoft Office Excel provides numerous predefined table styles (or quick styles) that you can use to quickly 

format a table. If the predefined table styles don't meet your needs, you can create and apply a custom table 

Choose a table style when you create a table 

On the worksheet, select a range of cells that you want to quickly format as a table.

Styles group, click Format as Table. 

 

Dark, click the table style that you want to use. 

Custom table styles are available under Custom after you create one or more of them. 
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table styles (or quick styles) that you can use to quickly 

format a table. If the predefined table styles don't meet your needs, you can create and apply a custom table 

cells that you want to quickly format as a table. 

after you create one or more of them.  
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Define the Print Area 

If you print a specific selection on the worksheet frequently, you can define a print area that includes 

just that selection. When you print the worksheet after defining a print area, only the print area will 

print. You can add cells to expand the print area as needed, and you can clear the print area to print 

the entire worksheet again. 

Set a print area 

On the worksheet, select the cells that you want to define as the print area. 

On the Page Layout tab, in the Page Setup group, click Print Area, and then click Set Print Area.  

Add cells to an existing print area 

On the worksheet, select the cells that you want to add to the existing print area. 

On the Page Layout tab, in the Page Setup group, click Print Area, and then click Add to Print Area. 

Clear a print area 

Click anywhere on the worksheet for which you want to clear the print area. 

On the Page Layout tab, in the Page Setup group, click Clear Print Area.  

 

Pivot Table 

Pivot table is a way to present information in a report format. This feature allows us to create a cross tabulation 

summary of data in which heading can subsequently moved to give different view of the data.  

1. Open the worksheet that contains the table you want summarized by pivot table and select any 

cell in the table. 

2. Click the PivotTable button in the Tables group on the Insert tab. 

3. If necessary, adjust the range in the Table/Range text box under the Select a Table or Range 

option button. 

4. Select the location for the pivot table. 

5. Click OK. 

6. To complete the pivot table, assign the fields in the PivotTable Field List task pane to the 

various parts of the table. You do this by dragging a field name from the Choose Fields to Add 

to Report list box and dropping it in one of the four areas called drop zones: 

Below is given how a  Pivot table is created from a table of sales figures of 3 salesmen for three months.  

Pivot Table (Salesman wise) 
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 Pivot Table (Month wise) 

 

 

 

Common Errors in Spreadsheet 

If you create a formula in Excel that contains an error or circular reference, Excel lets you know about it 

with an error message. A handful of errors can appear in a cell when a formula or function in Excel 

cannot be resolved. Knowing their meaning helps correct the problem. 
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Error Meaning 

#DIV/0! Trying to divide by 0 

#N/A! A formula or a function inside a formula cannot find the referenced data 

#NAME? Text in the formula is not recognized 

#NULL! 
A space was used in formulas that reference multiple ranges; a comma separates range 

references 

#NUM! A formula has invalid numeric data for the type of operation 

#REF! A reference is invalid 

#VALUE! The wrong type of operand or function argument is used 

 


